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SLC DIY 2 User Manual

Caution !
The Lambda sensor gets very hot, be careful when handling it.

During installation do not insert the Aux 1, Power, and Sensor cables into SLC DIY 2, once your wiring is complete then
insert the cables into SLC DIY 2. Automotive upholstery is a fantastic static electricity generator, inserting the cables
only after wiring is complete will greatly reduce the chance of damage to the unit by static electricity.

While the Lambda sensor is in an active exhaust stream, it must be connected and operated with SLC DIY 2 at all
times. Carbon from an active exhaust can easily build up on an uncontrolled Lambda sensor and ruin it.

Lambda sensor life when used with leaded fuels is between 100-500 hrs. The higher the metal content the shorter the
life of the Lambda sensor.

Do not install SLC DIY 2 in such a manner that the unit is powered before your engine is running. An engine start can
move condensation in your exhaust system to the Lambda sensor, if the sensor is already heated this can cause
thermal shock and cause the ceramic internals inside the sensor to crack and deform.

On some computers the device driver will only be valid for the USB port that was used for initial driver installation.
Plugging SLC DIY 2 into a different USB port will prompt your Operating System to ask for a device driver again, you
may install the driver again which will make the current USB port ok for SLC DIY 2, it will not invalidate the driver
install for any prior USB ports.

The proper procedure for downloading settings to SLC DIY 2 from SLC Config is as follows:

1) Download setting

2) Leave SLC DIY 2 on for 5 seconds
3) Turn Power off

4) Wait 5 seconds

5) Turn Power On

Failure to follow procedure may result in memory corruption and require a memory reset.
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1. SLCDIY 2 Hardware Installation
1.2 Fuses

2 Fuse holders, 2x 250ma fuses, and 2x 5A fuses, are provided. You only need 1 fuse of each type, the extra is for
replacement if required.

The fuse holders come with a single continuous wire connecting both ends of the fuse holder, cut the wire at the
midpoint. Do this for both fuse holders.

Fig 1.2.1: Fuse Cut

cut

The fuse holders open easily by twisting and pulling, observe that locking mechanism on the fuse holder is open before
attempting to pull.

In one fuse holder insert a 250mA fuse. The current rating of the fuse is etched on the metallic ends.

In the other fuse holder, insert a 5A fuse.

“System Power” Connects to switched 12[v] through the fuse holder with the 250ma fuse, see section 1.3.
“Heater Power” Connects to switched 12[v] through the fuse holder with the 5A fuse, see section 1.3.

1.3 Power, Auxiliary 1, Auxiliary 2, and Sensor

Fig 1.3.1: Power, Aux1, Aux2, and Sensor
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The Power cable has wire colors; Red, Black, Green, and White. The Power cable plugs into the Power connector.

The Auxiliary 1 cable has wire colors; Black, Green, Brown, Red, Orange, Yellow, White, and Blue. The Auxiliary 1 cable
plugs into the Auxiliary 1 connector.

14 7



Page |3

The Auxiliary 2 cable has wire colors; Black, White, Red, Green, and Brown. The Auxiliary 2 cable is soldered directly to
SLC DIY 2, there is no connector.

The Sensor cable has connectors on both ends, one end plugs into LSU Connector on SLC DIY 2, the other end plugs into

the Lambda Sensor.

Included in your purchase is 1 foot of heat shrink tubing, you should use a small section of heat shrink tubing on all

your connections to protect against moisture and dirt.

Table 1.3.1: Power Connection Table:

Connector | Wire Color Name Connects to Note
Pin #
1 Red System Power Switched 12[v] through 250ma Fuse Use fuseholder +
250ma Fuse
2 Black System Ground If you have a device connected to the
Linear Output, ground this point where the
device is grounded. Otherwise ground to
where ECU is grounded
3 Green LSU Heater Power | Switched 12[v] through 5A Fuse Use fuseholder + 5A
Fuse
4 White LSU Heater Ground | Ground to engine block or chassis
Table 1.3.2: Auxiliary 1 Connection Table:
Connector Pin # | Wire Color Name Connects to Note
1 Black RPM Input RPM input, tachometer or Optional
low side of ignition coil
2 Green Analog Input 2 | 0-5[v] output from sensor Optional
3 Brown Simulated Stock ECU if Lambda sensor Stops Stock ECU from
Narrowband replaces stock Narrowband throwing out a Check Engine
Output sensor Light when Narrowband
sensor is not detected.
4 Red EGT +ve 14Point7 EGT Probe Red wire | See note under Fig 1.3.3
5 Orange Analog Input 1 | 0-5[v] output from sensor Optional
6 Yellow Linear Qutput Aftermarket ECU, Datalogger, | Default Output; O[v] @ 0.68
etc... Lambda Linear to 5[v] @
1.36 Lambda, equivalent to
10-20 AFR for gasoline fuel
7 White Map Sensor 14Point7 MAP Sensor White | Optional
Input wire
8 Blue EGT -ve 14Point7 EGT Probe Blue See note under Fig 1.3.3
wire




All sensors must be dedicated to SLC DIY 2, you cannot share a sensor between a gauge and SLC DIY 2.

Fig 1.3.2: MAP Sensor Wiring Diagram

To
Engine

Nvlon Tube

Filter

e =

12v

White wire -> SLC DIY 2. Aux 1 cable. White wire

Black wire -> SLC DIY 2. Aux 2 cable. Black wire
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Note: Since there is only 1 Black wire on Aux 2 cable, you may need to split the Black wire with your own wiring.

Fig 1.3.3: EGT Probe Wiring Diagram

To
Exhaust

SLC DIY 2. Aux 1 cable, Red wire

=

SLC DIY 2. Aux 1 cable, Blue wire

Note: Keep Red and Blue wires on the Aux 1 cable as short as possible, i.e. try to run the EGT probe wires as close to

the Aux 1 connector as possible. EGT probe wires are made of a special material.

EGT Probe must be a k type thermocouple with an ungrounded junction, using a grounded junction EGT probe will

damage SLC Pure Plus 2 and void the warranty.

Table 1.3.3: Auxiliary 2 Connection Table:
Wire Color Name Connects to Note
Black Aux 2 Ground Ground for; MAP Sensor, Air Intake Optional
Temperature sensor, Oil Pressure
sensor, and Fuel Pressure sensor
White Fluid Temperature Sensor 14Point7 Fluid Temperature Sensor Optional
Input
Red Air Intake Temperature 14Point7 Air Intake temperature Optional
sensor input sensor Yellow Wire
Green Fuel Pressure sensor input 14Point7 Fuel Pressure sensor Optional
Brown Oil Pressure sensor input 14Point7 Qil Pressure sensor Optional

All sensors must be dedicated to SLC DIY 2, you cannot share a sensor between a gauge and SLC DIY 2.

Tt | [|




Fig 1.3.4: Fluid Temperature Sensor Wiring Diagram

Washer

Nut: turn nut to secure wire

To
Engine
Block

| SLC DIY 2, Aux 2 cable, White wire

Note: Copper colored end uses engine block as ground.

Fig 1.3.5: Air Intake Temperature Sensor Wiring Diagram

To
intake

SLC DIY 2, Aux 2 cable, Red Wire

_\— SLC DIY 2, Aux 2 cable, Black Wire
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Note: Since there is only 1 Black wire on Aux 2 cable, you may need to split the Black wire with your own wiring.

Fig 1.3.6: Fuel Pressure Sensor Wiring Diagram

To
Engine
Block

“M” labelled

T

SLC DIY 2, Aux 2 cable, Black Wire

i

SLC DIY 2, Aux 2 cable, Green Wire

“G” labelled

Note: Since there is only 1 Black wire on Aux 2 cable, you may need to split the Black wire with your own wiring.

Fig 1.3.7: Oil Pressure Sensor Wiring Diagram

“WK” labelled

To
Engine
Block

B sLcDIY 2, Aux 2 cable, Black Wire

i

I SLC DIY 2, Aux 2 cable, Brown Wire

“G” labelled

Note: Since there is only 1 Black wire on Aux 2 cable, you may need to split the Black wire with your own wiring.
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1.4 Wideband Sensor Installation

Cars Equipped with Narrowband sensor and stock ECU:

Remove the Narrowband sensor and replace it with the wideband Lambda Sensor. Your ECU will likely show a check
Engine Light if it does not detect the presence of a narrowband signal. Most of the time this can be fixed by routing the
Simulated Narrowband output from SLC DIY 2 to the Narrowband signal line to your stock ECU.

If your Narrowband sensor has a heater, in some cases the ECU will also check the heater current, if the Narrowband
sensor’s heater is disconnected the ECU may show a Check Engine Light. This can be fixed by placing a 10W 10ohm
power resistor between the Heater +ve and Heater -ve pins on your Narrowband harness. Alternatively you can leave
just the heater portion of the Narrowband sensor connected to the Narrowband sensor harness and route the
narrowband signal line to SLC DIY 2’s Simulated Narrowband Output, make sure the Narrowband signal line is physically
disconnected from the Narrowband sensor.

Alternatively you may keep your Narrowband sensor connected to your ECU and use the “All Others” method.

Cars Equipped Narrowband sensor and aftermarket ECU:

Remove the narrowband sensor from your exhaust and replace it with the wideband Lambda Sensor. Connect the
Linear Output from SLC DIY 2, see Table 1.3.2, to the lambda input of your aftermarket ECU.

All Others:

All others require the welding of the supplied 02 bung to your exhaust system before the catalytic converter. If your car
is turbo charged, weld the bung after the turbo exhaust outlet and before the catalytic converter.

Install the bung such that the sensor is within 90 degrees of vertical, best is within 45 degrees of vertical. This will
reduce the chance of water condensation on the sensor.

Fig 1.4.1: LSU Sensor Angle

<90 Deg \ﬁ

[ [
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Distance from engine exhaust port:

Typically, placing the lambda sensor where your stock oxygen sensor or about 1m from your engine’s exhaust port will
be fine.

Installing the Lambda sensor very close to your engine’s exhaust port may cause the sensor to overheat and expose the
Lambda sensor to high exhaust back pressure. Both will result in erroneous Lambda/AFR readings, overheating the
Lambda sensor will damage the sensor. This is especially true for turbo and super charged applications.

You can monitor the temperature of the Lambda sensor using the Winlog software, see section 6, if you notice that the
Lambda sensor temperature is consistently above 750[C] you should relocate the Lambda sensor farther away from your
engine’s exhaust port.

Installing the Lambda sensor too far from your engine’s exhaust port may cause the following problems; slow
Lambda/AFR response because it takes more time for the exhaust gases to travel a farther distance, if the Lambda
sensor is too close to your exhaust tip this will allow Free Air to mix with your exhaust gases and cause readings to be
overly lean, in some cases SLC DIY 2 will not be able to supply enough power to the Lambda sensor’s heater and the
sensor will be too cool this will result in erroneous Lambda/AFR readings.

Furthermore, if the Lambda sensor is in an active exhaust stream while being too cool, carbon can easily build up on the
sensor and ruin it.

You can monitor the Lambda sensor temperature using the Winlog software, see section 6, if you notice that the
Lambda sensor temperature is consistently below 750[C] you should relocate the Lambda sensor closer to your engine’s
exhaust port.

1.5 Grounding Considerations

1.5.1: When Grounding is important

If SLC DIY 2 does not need to output an external system via the Linear Output or need to input from an external system
via the analog inputs, then you do not have to worry too much about grounding points, just make sure the System
Ground is grounded near where your ECU is grounded and the LSU Heater Ground is grounded at a different point.

Interfacing the Simulated Narrowband Output to your ECU technically does require careful grounding, but the
narrowband signal is a very coarse signal, because of that grounding is not generally an issue for the Simulated
Narrowband Output.

Grounding is most critical when interfacing the Linear Output to a device such as an aftermarket ECU or datalogger
because the Linear Output provides very fine representation of AFR/Lambda and this information is usually used to
manage fueling.
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1.5.2: Making Good Grounds

The System Ground is the ground for the SLC DIY 2’s Electronics, this ground carries low current (<100ma) and is the
reference point that SLC DIY 2 uses, i.e. this is a very important ground.

The LSU Heater Ground is the ground for the heater inside the Lambda sensor, this ground carries high current (1amp —
3 amp), the LSU Heater Ground is not used as a reference point but only as a path for heater current, i.e. it is not as
important as System Ground.

System Ground should be grounded as close as possible to the ground of the device using the Linear Output. If you have
no device using the Linear Output, then System Ground should be grounded as close as possible to the ground of the
device connected to the Analog inputs for datalogging. If you have no devices connected the Analog Inputs, and then
System Ground should be grounded close to your ECU ground.

LSU Heater Ground should be grounded far from where the System Ground is grounded, usually the chassis or the
engine block is a good choice.

1.5.3: Verifying Good Ground
This Section only applies if you have a device connected to the Linear Qutput.

Good ground is most critical in setups where the Linear Voltage Output is used, SLC DIY 2 has a method to verify the
quality of your grounding. By forcing the output to a specific voltage, 2.35[v], and looking at the AFR/Lambda/voltage
read by the device connected to the Linear Output while your engine is under load, you can verify that the Linear Output
is accurate which is indicative that your grounds are good.

If Possible, configure the device connected to the Linear Output with the AFR/Lambda curve “10 AFR @ O[v] linear to 20
AFR @ 5[v]” or with the Lambda curve “0.68 Lambda @ O[v] linear to 1.36 Lambda @ 5[v]".

e Install SLC DIY 2 according to the prior sections

¢ Install the Lambda sensor according to section 1.4

e Connect the Lambda sensor to SLC DIY 2 via the supplied sensor cable

¢ Install SLC Config and USB drivers according to Section 4

e Start your engine

e Connect SLC DIY 2 to your Laptop via the supplied USB cable

e Run SLC Config according to Section 5

¢ Inthe “Linear Voltage Output Test” section of SLC Config, click “Force 2.35[v]”
e Put normal load on your engine

If the device connected to the Linear Output is configured with the correct AFR/Lambda curve, the AFR read by the
device should always be “14.7”, Lambda should always be “1.00”. Variations of +/- 0.1 AFR or +/- 0.01 Lambda are
acceptable.
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If the device connected to the Linear Output is configured to read raw voltages, the voltage read by the device should

always be “2.35[v]”. Variations of +/- 0.08[v] are acceptable.

If the AFR/Lambda/Voltage read by the device connected to the Linear Output is consistently above or below
14.7[AFR]/1.00[Lambda]/2.35][v], it is likely the problem is not grounding but with the
configuration/hardware/connection/etc... of the device connected to the Linear Output.

If the AFR/Lambda/Voltage read by the device connected to the Linear Output has large fluctuations around
14.7[AFR]/1.00[Lambda]/2.35[v], the problem is likely due to grounding. | suggest you confirm that the System Ground
connection is clean, well connected, and grounded near where the device connected to the Linear Output is grounded,
move the LSU heater ground to another point farther from the System Ground, and run the test again.

After the Linear Output has been forced to 2.35[v], a subsequent power cycle to SLC DIY 2 will restore normal
operation to the Linear Output.

1.6 Accelerometer Vs. Analog Inputs

SLC DIY 2 has an onboard dual axis accelerometer, the output of the accelerometer is shared with the dual Analog
inputs. The Cornering G force input is shared with Analog Input 1, the Acceleration/Deceleration G force input is shared

with Analog Input 2.

Configuring the Jumpers on “JP5” will select between Accelerometer and Analog Inputs. JP5 is located in the middle of
the PCB, you will need to remove the casing to access JP5.

Accelerometer and Analog Input data is only available through datalogging; real-time via Winlog. The faceplate

display will not show Accelerometer or Analog Input data.

For Accelerometer data to be accurate you must calibrate the Accelerometer according to section 5.8.

Table 1.6.1: JP5

JP5 Setting | Input 1 Input 2 Note

llll un | Cornering G force | Accel/Decel G force | Default setting from
[a

factory
llll 0 Analog Input 1 Analog Input 2

IIII n | Analog Input 1 Accel/Decl G force
[a W

Illl 0 Cornering G force | Analog Input 2
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2. SLCDIY 2 Display and Internal Memory Usage

2.1 Cycling Display Parameters

Fig 2.1.1: SLC DIY 2 faceplate

11—
-

Quickly pressing the Faceplate Button will cycle the display parameter; AFR, EGT, Boost, Fluid Temperature, Air Intake
Temperature, Fuel Pressue, Oil Pressure, and Datalog Status. You must purchase compatible sensors from 14Point7 and

correctly install the sensors to show corresponding parameters.

All sensors must be dedicated to SLC DIY 2 you cannot share a sensor between a gauge and SLC DIY 2. Only sensors
sold by 14Point7 should be used.

Before each parameter is displayed, the name of the parameter will momentarily be shown.

Table 2.1.1: Display Name and Range

Name Shown Parameter Name Range of Display Note

I_ - Air to Fuel Ratio 10.26 - 99.99 AFR range depends on the AFR

[_”_ I_ conversion, for gasoline the range is
10.26 —99.99

I_ I_ o Exhaust Gas Temperature 0[C] - 1200I[C] Requires calibration using the SLC

Config software, see section 5.10

Boost

O[PSI] — 43.5 [PSI]

Faceplate will only display positive
boost pressure. Real time datalogging
will show Vacuum and Boost

I Fluid Temperature 0[C] - 150[C]
-
[~ Ny Air Intake Temperature 0[C] - 150[C]

Fuel Pressure

0[PSI] - 145[PSI]

Oil Pressure

O[PSI] — 145[PSI]

EGT, Boost, Fluid Temperature, Air Intake Temperature, Fuel Pressure, and Oil Pressure parameters are displayed
using a simplified mathematical model. For those metrics there will be a slight difference between the values

displayed on the faceplate and Real Time datalogging.
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3. SLCDIY 2 First Time Usage

If you have followed instructions up to this point, for a simple setup in which you want to visually display AFR, Boost,
EGT, Fluid Temperature, Air Intake Temperature, Fuel Pressure, Oil Pressure, and/or interface the Linear Output with an
external system such as an ECU or datalogger, you can stop here and enjoy your SLC DIY 2 unit as is. Your SLC DIY 2 will
be able to achieve 0.01 Lambda accuracy without any additional steps.

Continue on reading if you desire additional features such as Datalogging and Free Air Calibration.
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4. Software Installation

You will need to install 2 pieces of software; SLC Config and Winlog. SLC Config is a configuration utility for SLC lambda
controllers, Winlog is a datalogging and data visualization software.

The SLC Config installer can be found on the included CD, double click the “SLC_Config_Deploy_x_xx.exe” filename to
begin the installation process. This software is compatible with windows XP/Vista/7 only.

The Winlog installer can be found on the included CD, run the “Winlogsetup_14Point7” executable to begin the
installation process. This software is compatible with windows XP/Vista/7 only.

For the most up to date software and documentation please visit http://www.14point7.com/Support.php

4.1 USB Driver Installation and Usage

SLC DIY 2 cannot be powered by USB, it must be powered from the Power cable.

USB Driver Installation:

Power on SLC DIY 2, connect SLC DIY 2 to your PC’s USB port using the supplied USB cable. Windows will notify you that
it has detected a new device and ask you for the location of the driver. The driver location is in the “\Driver\SLC_DIY2”
directory of the SLC Config installation directory. If you used the default installation directory, the driver is located in
“C:\Program Files\14Point7\SLC_Config\Driver\SLC_DIY2".

If you are using the supplied CD, The driver is also located in the “\SLC_DIY2\Driver” directory of the CD.

ComPort#:

Once the driver is correctly installed and SLC DIY 2 is connected to the USB port of your PC, Windows will assign a
Communications Port Number (ComPort#) to the device. You will need to know the ComPort# Windows has assigned to
SLC DIY 2 when using the SLC Config and Winlog software. In Windows XP/Vista/7 you can check in your “Device
Manager” to find the correct ComPort#.
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Fig 4.1.1: Device Manager, ComPort#

5, Device Manager

File Action View Help
= W& @
=) E TOALAN-ADSBS]Z]

+ H8 Acronis Devices

+ \ Batteries

+ ¢ Computer

+ e Disk drives

+ ¥ Display adapters

+5 DVD/CD-ROM drives

+ =) Floppy disk controllers

+- M4 Floppy disk drives

+ (&9 Human Interface Devices

+ (=) IDE ATAJATAPI controllers

+ » Keyboards

+ ';)‘ Mice and other pointing devices

+ H8 Network adapters

= Y Ports (COM&LPT)
“_'_\y‘ Communications Port (COM1)
7 Communications Port (COM2)
“_y Printer Port (LPT1)
 sLc_Div2 (Com12)

+ % Processors

+ €= SCSI and RAID controllers

In the above example, the correct ComPort# is “COM12”.

On some computers the device driver will only be valid for the USB port that was used for initial driver installation.
Plugging SLC DIY 2 into a different USB port will prompt your Operating System to ask for a device driver again, you
may install the driver again which will make the current USB port valid for SLC DIY 2, it will not invalidate the driver
install for any prior USB ports.
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The proper procedure for downloading settings to SLC DIY 2 from SLC Config is as follows:

1) Download setting

2) Leave SLC DIY 2 on for 5 seconds
3) Turn Power off to SLC DIY 2

4) Wait 5 seconds

5) Turn Power On to SLC DIY 2

Failure to follow procedure may result in memory corruption and require a memory reset.
Symptoms of memory corruption:

e Linear Voltage Output is static regardless of exhaust Lambda

¢ Simulated Narrowband output is static regardless of exhaust Lambda

¢ Numeric Display on SLC DIY 2 is static regardless of exhaust Lambda

¢ Numeric Display on SLC DIY 2 is blank or the refresh rate is too high or too low

Memory corruption can be fixed by hitting the “Reset SLC Memory” button in the SLC Config software, this will reset the
memory onboard SLC DIY 2 with safe default values. After a memory reset, all previous stored settings will be lost.

Specify the correct ComPort# and hit the “Query Device” Button, SLC Config will interrogate the connected USB device
at the selected ComPort#, see section 4.1, and automatically unlock functionality specific to your SLC DIY 2 model.

You must perform a “Query Device” before being able to change and adjust SLC DIY 2 settings.

14 7
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5.3 AFR Conversion

Lambda is converted to Air-to-Fuel Ratio (AFR) by a multiplication factor; AFR=Lambda * AFR Conversion. Below is a
table of Conversion Factors for various fuels

Gasoline 14.7

LPG (Propane) 15.5
Methanol 6.4
Ethanol 9.0

CNG 17.2

Diesel 14.6

Hit the “Write AFR Conv Settings” button to download a new AFR Conversion setting to SLC DIY 2.

5.4 Linear Voltage Output

This section allows you to adjust the 0-5[v] linear representation of AFR/Lambda. The linear voltage output from SLC DIY
2 is typically connected to your datalogger or aftermarket ECU to convey the measured AFR/Lambda of your exhaust gas
to that device.

The default Voltage vs Lambda output is; 0O[v] @ 0.68 Lambda linear to 5[v] @ 1.36 Lambda, for gasoline this is
equivalent to O[v] @ 10 AFR linear to 5[v] @ 20 AFR.

To change the Voltage vs Lambda output, you must specify the Lambda @ Ov and the Lambda @ 5v, all points in
between will be automatically linearly interpolated.

Hit the “Write Vout Settings” button to download new Linear Voltage Output settings to SLC DIY 2.

5.5 Narrowband Switch Point

This section allows you to adjust the Simulated Narrowband output. In some SLC DIY 2 installations, the Bosch
Wideband Lambda sensor will physically replace the stock narrowband sensor and the Simulated Narrowband output
from SLC DIY 2 is connected to the Narrowband Signal wire feeding your ECU. Your ECU controls fuel enrichment of your
engine at light engine loads based on the output of the Simulated Narrowband signal, the ECU’s goal is to maintain the
engine at stoich to maximize efficiency and minimize pollution at light engine loads.

The default Lambda Switch Point is “1 Lambda”, at Lambda =1 the Simulated Narrowband Voltage is 0.45[v]. When your
ECU sees 0.45[v] it will believe that the engine is running stoich. By shifting the switch point to below 1 Lambda, your
engine will run richer at light engine loads. By shifting the switch point above 1 lambda, your engine will run leaner at
light engine loads.

Hit the “Write NB Switch Point” button to download a new Narrowband Switch Point to SLC DIY 2.
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5.6 RPM Configuration

This section allows you to adjust the RPM Pickup settings to match your engine’s ignition configuration.

Table 5.6.1: RPM Multiplier

Ignition Type # of Cylinders SLC Config RPM Multiplier
Coil on Plug Does not matter | 0.5
Wasted Spark Does not matter | 1
Distributor 2 1
Distributor 3 0.667
Distributor 4 0.5
Distributor 5 04
Distributor 6 0.334
Distributor 7 0.286
Distributor 8 0.25
Distributor 9 0.222
Distributor 10 0.2
Distributor 11 0.182
Distributor 12 0.167
Distributor 13 0.154
Distributor 14 0.143
Distributor 15 0.133
Distributor 16 0.125

5.7 Linear Voltage Output Test

This section allows you to force the Linear Output to a static 2.35[v] for the purpose of testing the quality of your ground
wiring. Refer to section 1.5 for more information.
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5.8 Accelerometer Calibration
This section uses the known G force of gravity to calibrate the onboard dual axis accelerometer.

Configure JP5 so that both cornering and accel/deccel G force inputs are selected according to section 1.6.

Fig 5.8.1: Acceleration Calibration

Faceplate

side

Side with
connectors

Orient SLC DIY 2 according to fig 5.8.1, side with connectors faces ground. Make sure that the unit is perfectly vertical
and square to the direction of gravity. Hold the unit still and click the “Accelerometer Acceleration Calibration” button in
the “Accelerometer Calibration” form.

Fig 5.8.2: Deceleration Calibration

L L

Side with
connectors

Faceplate

side

Orient SLC DIY 2 according to fig 5.8.2, faceplate side faces ground. Make sure that the unit is perfectly vertical and
square to the direction of gravity. Hold the unit still and click the “Accelerometer Deceleration Calibration” button in the
“Accelerometer Calibration” form.
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Fig. 5.8.3: Left Turn Calibration

Orient SLC DIY 2 according to fig 5.8.3, right side faces ground. Make sure that the unit is perfectly square to the
direction of gravity. Hold the unit still and click the “Accelerometer Left Turn Calibration” button in the “Accelerometer

Calibration” form.

Fig. 5.8.4: Right Turn Calibration

Orient SLC DIY 2 according to fig 5.8.4, left side faces ground. Make sure that the unit is perfectly square to the direction
of gravity. Hold the unit still and click the “Accelerometer Right Turn Calibration” button in the “Accelerometer

Calibration” form.

When you have completed all 4 accelerometer calibrations the “Accelerometer Calibration Values” will be populated
with 4 calibration values, you enter these 4 calibration values into the Winlog application in the “Winlog Config for SLC
PP2/DIY2” form, see section 6.1
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5.9 Free Air Calibration

5.9.1: Free Air Calibration
Free Air Calibration uses the known 02 concentration of “Free Air”, 20.9%, as a gas to calibrate a Lambda sensor.

SLC DIY 2 with a sensor in good condition is able to achieve 0.01 Lambda accuracy without the need for Free Air
Calibration.

The primary purpose of Free Air Calibration is to account for sensor aging, it also generally tends to slightly increase
accuracy even for new sensors.

A bad Free Air Calibration will cause inaccurate Lambda readings, often the error will be small enough such that it is not
obvious yet large enough to put your engine in jeopardy. Therefore, it is very important to correctly follow the
instructions shown in the “Free Air Calibration” form.

Free Air Calibration Schedule:

Normally Aspirated Engine: Calibrate once a year or every 40,000 miles, whichever comes first.
Turbo/Super Charged Engine: Calibrate once every 6 months or every 20,000 miles, whichever comes first.
Race Engine: Calibrate every other race weekend.

Dynometer: Calibrate once a week.

5.9.2: “Reset Calibration Value”

The “Reset Calibration Value” button will reset the free Air calibration to a factory value, the factory value reflects a
Lambda sensor in “perfect” condition.
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5.10: EGT Calibration

EGT Calibration calibrates the attached Exhaust Gas Temperature Probe for increased accuracy. It is important to
correctly follow the instructions in the “EGT Calibration” form.

Once EGT calibration is complete, the software will show the “EGT Calibration Value”, you enter this value into the
Winlog application in the “Winlog Config” form, see section 6.1.
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Winlog is a third party Datalogging and Data Visualization program. Winlog is not created by 14Point7. 14Point7
provides a full and unrestricted copy of Winlog with every SLC DIY 2 purchase.

Winlog is a fully featured and powerful piece of software, you should read the installed Winlog user manual for a
complete understanding of its capabilities. The following Winlog instructions only touch upon very basic features to
allow the user to quickly get started.

It is a good idea to watch this short Winlog tutorial video before continuing,
www.14Point7.com/Support/Software Documentation/Winlog SLC Tutl.wmv

The following instructions will setup the SLC DIY 2 Driver in Winlog.

™ WinLog 14point7 v1.04betal
o Heb

Click Add

¥ Auto-Reconnect Disconnected Devices

'LJM
Click Add



Configure Logging Device Settings

C

onfigure Logging Devices:

Select Device

[Sample Winlog Driver OK I
[SLC DIY 1, FW 1.02, Driver Version 1.01
(SLC DIY 1, FW 1.034 Driver Version 1.01

Cancel
SLC DIY2, Driver Version 1.00 ek
SLC PP1, Driver Version 1.03
[SLC PP2, Driver Version 1.00
Have Disk.

| —y m—

OK Cancel

Select “SLC DIY2, Driver Version x.xx” then click “ok”

Serial Port:
RPM multiplier: 2.00

AFR conversion: 14.70

EGT Calbration 0.00

Accelerometer Acceleration Calibration Value: | 102.00
Accelerometer Decceleration Calibration Value: | 62:00
Accelerometer Left Turn Calibration Value: 102.00

Accelerometer Right Turn Calibration Value: | 62.00

o] o

Configure Logging Device Settings
f Winlog Config for SLC DIY2

+

o arer

[ETETCT

Select the correct serial port, see section 4.1

Input the correct RPM Multiplier for your engine, see section 5.6
Input the desired AFR Conversion, see section 5.3

Input the EGT Calibration Value, see section 5.10

Input the 4 Accelerometer Calibration Values, see section 5.8

Click “OK”

Configure Logging Device Settings

2

Configure Logging Devices:

SLC DIY2, Driver Version 1.00

f

Auto-Reconnect Disconnected Devices

Reconnect Delay: | 10 (seconds)
oK Cancel
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Click “OK”

IV inLog 14point7 v1.04betal
Ll Edt View Help
New Datalog

Open Datalog

New Dashboard

Save Dashboard As..

e \

File->Open Dashboard

Select dashboard file 5]
Lookin: [ 3 WinLog =) c¥ E8-
3
-9
My Recent
Documents |23 wiriop_Dash_1_03_SLC_F
| Winlog _Dash_SLC_Pure_DIY_2_1024_600.dsh|
Desktop
My Documents
8
My Computer
‘) il name [Winlog_Dath_SLC_Pue_OIY_2_1024 600 .
-
MyNetwork  Files of type: Dashboxd Fie {* dsh) - Cancel
flces Open a3 read-only

Select “Winlog_Dash_x_xx_SLC_DIY_2_1024_600.dsh” then click “Open”

I WinLog 14point7 v1.04beta1
File Edit View Help

0l 14 s

Fluid Temp

Chart

NOT LOGGING ‘Warnings:0
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If SLC DIY 2 is connected to your PC via USB and the Comport# is correctly set, the dashboard should be updating with

live data from SLC DIY 2.

7
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Open Last Datalog

New Dashboard
Open Dashboard...
Save Dashboard
Save Dashboard As...

Exit

File->New Datalog

Winlog by default will automatically generate a filename based on time and date and save the datalog file to the Winlog
installation directory, you can change this in View->Dash Configuration.

| I WinLog 14point7 v1.044
GY Edit View Help
New Datalog
Stop Logging
Open Datalog
Open Last Datalog

New Dashboard
Open Dashboard...
Save Dashboard
Save Dashboard As...

File->Stop Logging, will stop datalogging to Hard Disk.
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7. WinlogView
WinlogView is a program to view datalogs saved from Winlog.

WinlogView is a fully featured and powerful piece of software, you should read the installed WinlogView user manual
for a complete understanding of its capabilities. The following WinlogView instructions only touch upon very basic
features to allow the user to quickly get started.

Wi WinLogView 14point7 1.02betal - a.txt
78 View Help

Open Log CTRL+O

Open Graph CTRL+G

Save selection to new log
Export Graph Image

ALT+F4

File->Open Log

x| «®crB@

& — % :
4
Pleces Open a1 ieadorly

Browse to where the saved datalog is located and click “Open”

Wi WinLogView 14point7 1.02be
File BUETE Help
> Fields CTRL+F
Zoom In NUM +
Zoom Out UM -
Zoom Out Full

v Graph Mode
Matrix Mode

Large Toolbar

View->Fields
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Graph Fields

Available Fields.

X Axis Fieki: - Corfigure Field..
[logtme |

* | comal

Select the fields you want to display with the “->” button. In the “X Axis Field” you usually want to select “Logtime”. Click
“Ok” to display the data in graph form.
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SLC DIY2 carries no warranty.

14Point7 is liable for damages only up to the purchase price of its products. 14Point7 products should not be used on
public roads.

14 7



